
MARS System 7 Draft:  10/28/2012 Page 1 of 19 

 
White Paper Describing  
 

MARS System Seven 
 

MARS Opportunity Seven 
MARS Intel Reporter Seven 

 
MARS Phobos is described in detail in another document. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
This is a draft document as of October 28, 2012.  Some elements are subject to change. 
 
This paper is designed to provide detailed information as to the features, benefits and 
general operational capability of MARS System 7 
 
For more Information, or to arrange a demonstration,  
please call:  (800) 519-0463 
 
 
MARS Group Software 
P.O. Box 9868 
Fresno CA  93794 
 
www.mars-group.com 
MS7Info@mars-group.com 



MARS System 7 Draft:  10/28/2012 Page 2 of 19 

General Description of MARS System 7 
 
MARS System Seven is collection of three (3) applications, plus utility programs to facilitate 
management and reporting of data from special student populations, such as McKinney-
Vento Homeless, Foster, Healthy Start, Neglected/Delinquent, and other student populations 
where services and other membership characteristics are delivered in a similar manner. 
 

1. For a District/LEA that manages one or many programs within a common 
district network, the MARS Opportunity Seven deployment option combines 
a versatile Case Management application with a vastly improved, and highly 
intuitive MARS Intel Reporter Seven.   

 
2. For a County Office of Education, Educational Services District or Consor-

tium that must collect program data from a number of outlying districts with 
restrictions on sensitive data transfer, the MARS Phobos system allows out-
lying districts to transmit a single encrypted student ID number along with 
related services and program participation characteristics… no sensitive 
data other than the ID is transmitted.   
 
Reporting  and site control is from MARS Intel Reporter Seven, and site in-
put is through a freely distributed MARS Phobos application, or optionally,  
any edition of MARS Opportunity 7 (including the “free” MARS Opportunity 
7 LE).  MARS Phobos is described in detail within another document. 

 
3. For existing MARS Opportunity 5 and 6 systems that just don’t want to 

change from what they are already accustomed, MARS Intel Reporter 
Seven is available independently as an upgrade providing a highly intuitive 
reporting system.  Gone are the days of exporting into a spreadsheet and 
then eliminating unwanted data for a given report.   

 
We have taken the things that make sense from user’s “wish lists” of previous MARS sys-
tems, and combined them with features that were not even imaginable in the older versions.   
 
Here is a partial list of changes and benefits in the new MARS System Seven: 
 
For people who enter students, program participation data, services and contact in-
formation (MARS Opportunity Seven): 
 

 The user experiences a faster “feel” in the application. 
 Both the data entry (MARS Opportunity 7) and the reporting portion (MARS Intel 7) 

are fully integrated into one application. 
 There is only one (1) screen for selecting and editing information. 
 There are express entry screens for entering “spreadsheet style,” services for con-

secutive entry of services… pick a student and select a service, then go to the next 
line. 

 A similar express screen is available for logging contacts. 
 Logs are displayed and editable from the main case manager screen. 
 User preferences allow each user to set the default start screen… case managers 

can choose the main Case Management screen, service providers can choose the 
Express Service Entry.. so on. 

 Extensive reports for student list, or individual student information are immediately 
available, for active/inactive student list, Case Manager’s student list, or list by pro-
gram characteristic. 

 We’ve added six (6) custom Yes/No fields for a total of 5 custom list fields, and 10 
custom Yes/No Fields. 
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 Additional “Other ID” number field has been added to use for state or other district 
student ID. 

 Primary Night Residence field is now with both the family and/or individual student… 
you may use both. 

 Students can be placed into virtual Membership Groups. 
 
 
 
For people who report from MARS (MARS Intel Reporter Seven): 
 

 With MARS Intel Reporter, administrators, evaluators and research people work with 
data in a spreadsheet style, in a “what you pick is what you get” environment. 

 Right click on a cell and filter by the cell value with a single mouse click.  Place filter 
upon filters.. 

 Clean split screen user interface… spreadsheet data on top, selected report on bot-
tom of screen. 

 Report template reflect whatever data is in the filtered data spreadsheet.  Available 
reports templates for specific MARS Data List now in the system are in the hundreds. 

 Services can be put into groups and saved.  So, you can attribute Gas Cards and 
Bus Tickets to “Homeless EOY: Transportation,” and the same services plus other 
services could also apply to “Foster EOY: Direct Services.” 

 Reports can be saved with their filter criteria.  Rerun exactly the same report. 
 Saved Reports can be placed into groups and run from a list… i.e. Homeless EOY, 

Foster EOY, Healthy Start Grant, District Board, etc.  Save into groups as you actu-
ally use them in the real world. 

 External data can be imported and merged by a common field with a MARS Data List 
and then used for Report Criteria… i.e. STAR Test Scores by CSIS Number. 

 Reports can be printed to any connected printer, saved as a PDF file, or exported 
(most reports) to MS Excel. 

 Ability to export encrypted data to outside parties, 
 
 
 
For people who install and manage the system (IT): 
 

 Installation is from a single download for each computer. 
 System checks and updates to latest version automatically on start.  Any new reports 

or system changes are automatically installed each time the system starts. 
 An included subscription through the 2012 School Year allows for custom creation of 

non-defined report templates.  New reports are automatically pushed to your system 
along with any other new report templates from other request. 

 Login security for each user. 
 Standardized MARS design.  All systems get the same features. 
 Can use either MS SQL Server 2003 or greater, or MS Access Database for data 

storage.  (MS SQL Server 2008 Express Edition available free and automatically in-
cluded upon installation). 

 Runs under Microsoft .NET Framework managed code for vastly improved computer 
fault tolerance. 

 Built-in management of external data acquisition for linked SIS data. 
 
The following pages provide details and graphics of the features listed on this and the previ-
ous page: 
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MARS Opportunity Seven:  
 
History: 
The basis for MARS Opportunity dates back to 2000.  Starting during the 2000-2001 school 
year, we developed a number of database systems for Fresno Unified School District (FUSD) 
under the direction of their now retired deputy superintendant, Robert Harris.  These systems 
managed Student Attendance Review Board (SARB) cases,  transfer applications, and sev-
eral other Student Services functions. 
 
One of these of the systems we created was a database system that managed student activ-
ity for McKinney-Vento Homeless students.  Following the meticulous requirements provided 
by Dr. Laura Tanner, the manager of the FUSD’s Project Access, we created a database sys-
tem to track and manage their McKinney-Vento Homeless students.  Among those require-
ments was the ability to manage students as a family, record each service provided to a stu-
dent, manage telephone calls, and assign a case manager to each call/contact activity in a 
quantifiable manner. 
 
We wanted to build a system that provided the individual user with enough benefits that they 
would want to enter the data for their own benefits, opposed to it being a task required for the 
managers.  So we provided ease of entry such as selections of a target students from a drop 
down list, tied into the FUSD SIS system to glean new student and their associated data, as 
well as enough quick reporting capability to satisfy each case manager. 
 
A year later an interesting thing happened:  The National Association for the Education of 
Homeless Children and Youth (NAEHCY) gave the Project Access program an award that 
among other qualities, the data gathering and management components of the Project Ac-
cess program were key reason they were awarded.  We attended the NAEHCY conference 
where Dr. Tanner presented her program, where she described her data system, and were 
overwhelmed with school districts interested in using the same system. 
 
Taking a system that designed for one specific program, and making it work for any program 
of similar type present a number of challenges.  It took a year for us to create a completely 
different application to offer to anyone.  This system was designed around Microsoft Access, 
Visual Basic Applications control objects, combined with coded Visual Basic and Visual Basic 
Applications procedures.  Over the years, we installed and maintained a number of systems, 
mainly in the western United States to facilitate our ability to service those applications in an 
efficient manner. 
 
The old MS Access type MARS 
Opportunity systems (shown 
right) worked extremely well.  
They provided these special 
population programs with an ap-
plication that was very user-
friendly and gave them the kind of 
case management and data 
gathering control that is not avail-
able from most student informa-
tion type programs.  To be clear, 
none of the MARS system appli-
cations was ever intended to be a 
student information system such 
as PowerSchool, Aeries, or 
ESchool Plus. 
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MARS Opportunity Seven:  Faster end-user “feel” 
 
MARS Opportunity Seven, the Case Management portion of MARS System Seven has a 
much faster feel when interacting with students and their associated families.  There are sev-
eral reasons why.  First, the system loads all data onto the local computer when the Case 
Managers View is initially opened.  So as you navigate from student to student, you’ll experi-
ence an almost instantaneous change from record to record.  The exception to this is when 
you actually save to, or refresh data from the MARS System database. 
 
 
The second reason is that nearly eve-
rything is on one screen, including 
most editing of information.  You want 
to select a different student. You just 
click the Select Student dropdown by 
either typing in a few letters of their 
name or ID number. Alternatively, one 
may select from clicking the dropdown 
and selecting directly from the list.  
There is no navigating out to a selec-
tion screen, choosing a select method 
and then the students on the list… 
those steps are eliminated in the new 
system. 
 

Right:  Case Managers View showing 
dropdown selection list.  Note that you can 
change the selection from Name to ID on 
the fly.  No more going to a family and then 
double clicking a student.   

 
Logs are accessible from the main screen with a single mouse click… no more navigating 
menus to select the service log.  And the end-user may set in “User Preferences” what log  
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 (Services, Contact or Student Address Log) they would like in the default view when they en-
ter the Case Manager View. 

 
 
Left:  Log section 
(lower right from previ-
ous page graphic) al-
lows instant access to 
user preference Ser-
vice, Contact or student 
address logs. 
 

 
Entering data into the Services log is quick and easy.  In the new MARS Opportunity Seven, 
end-users will love the 
ability to enter one or 
many services to one 
student, all family 
members, or selected 
family members using 
the log’s “Quick Add” 
button.  No need to 
copy and paste from 
one student log to an-
other. 
 
In the graphic to the 
right, the Quick Ser-
vice Add window is be-
ing used to create a 
new service entry for 
each of the four se-
lected services (top left) to be applied to each of the four (4) selected family members (lower 
middle).   

End-users may also 
use an Express En-
try window for ser-
vices to be applied 
to many different 
students without re-
gard to families.  In 
fact, using the Ex-
press Services Entry 
window, an end-user 
may apply one ser-
vice to every student 
on the current drop-
down list as shown 
in the screen capture 
on the right. 
 
There is also an Ex-
press Student window for applying program participation and characteristics to groups of stu-
dents. For example, you want to mark a group of students as Unaccompanied, you can apply 
that setting to a group of students in one operation in the same manner as described for Ex-
press Services. 
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User Preferences 
 
Each end-user can set a number of aspects to the way they interact with students, and the 
way they want certain screens to appear.  One major setting is what screen they wish to be 
as their default screen on start up.  If the end-user spends most of their time working with ap-
plying services, Each user can set their initial screen to always be the Express Services entry 
instead of the default Case Manager View.  Similarly, they can choose the Express Students 
Screen, Contact Activity Log, or just leave keep the default Case Manager View. 
 

 
Additionally, the Case Manager View can be set to run in “Compact Mode” for a better fit on 
older displays, to show a larger screen at lower resolution settings, or just for a less cluttered 
view of information.  The main change in “Compact Mode” is the Family information is avail-
able from a toolbar above the main student information.  This setting can be made as the 
end-users default view, or it can be changed on the user’s demand from the “Tools” menu. 
 
Quick Reports 
 
This system contains two reporting methods, “Quick Reports” available from a single menu 
selection, and MARS Intel Reporter Seven that is now integrated into the MARS Opportunity 
Seven application.  MARS Intel Reporter Seven is described in detail in the next section and 
is entirely different from prior versions.  We’ll concentrate here on what reports are available 
directly from the File> Print menu as shown in the graphic on the next page. 
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Right:  The callout 
section on the right 
shows the selection 
for a quick list report 
for the case man-
ager named Jessie 
James.   

Quick reports are 
displayed in the 
Student reports win-
dow.  In the exam-
ple below, we are 
showing the result for a list of students to be printed.  The end-user may use either the 
 

 
 
default columns, or the end-user may chose what data columns he/she wants to display in 
the list.  Additionally, all reports can be printed to any connected printer including FAX print-
ers, and can be saved as a PDF file for distribution outside of the MARS system.  Most list 
reports can be exported to an Excel spreadsheet. 
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Individual Student Reports for any selected student in the Case Manger View include Pro-
gram/Enrollment Summary that prints pretty much all the MARS information for the selected 
student.  These reports are all printed from the same style window as on the previous page. 
 
Program/Enrollment Summary w/Family prints the same information with a list of siblings at 
the end of the report.  Services, Contact Activity Summary, and Student Addresses\Housing 
log are printed from the File> Print > Student Reports menu, or directly from any log view’s 
right click context menu.  Custom Views are displayed and printed directly from the custom 
view screen, which is identical to the Student Report screen. 
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Other Notable Changes In MARS Opportunity Seven 
 

 Individual Primary Night Student Housing/Log: Primary Housing for any student is 
now recorded for both the family and the individual student in a housing log.  An entry 
into the housing log may be “inherited” from the family (“With Family”), or may be en-
tered directly for the individual student.  In MARS Intel Reporter Seven, the initial stu-
dent Housing value and the most current Housing value are both displayed with the 
other student census data that can be used as data filters.  The family housing value 
is also available.  This eliminates the need to move a student living outside their fam-
ily’s household to a solitary family for that student only.  Additionally, the log itself has 
additional value as a case management tool if you ever have the need to go look for 
a student. 

 
 Special “Unaccompanied” field: It is no longer necessary to create custom fields 

and values to handle unaccompanied students.  This check box is now a standard 
entry value.  This eliminates varying set-up scenarios for tracking unaccompanied 
students, and allows the student to optionally be placed in the same family with their 
other siblings for better case management. 

 
 15 Custom Fields Available:  We added six (6) “Yes/No” fields into the data struc-

ture to allow greater flexibility to track different program participation and use the sin-
gle MARS Opportunity for tracking these programs from one system.  So, you can 
create a “Yes/No” fields for Homeless, Foster, Healthy Start, and/or any other pro-
grams up to a total of ten different programs and/or characteristics.  Plus there are 
still five (5) custom fields that have list values associated with them available from 
dropdown selections.  Note: Unaccompanied is included in the total “Yes/No” custom 
fields. 

 
 Virtual Membership Groups:  As a catchall, the administrator can create a virtually 

unlimited number of Membership Groups.  Mem-
bership can be entered for any student by selec-
tion of “Group Membership” from the “Select 
Other Log/View” menu in the Case Manager 
View, or Memberships can be applied to groups 
of students in the Express Students Entry view. 
 
Virtual Membership can be used as a filter in 
MARS Intel Reporter Seven, making it easy to 
define groups of students for reporting purposes. 

 
 “Other ID” Number:  There is now second optional ID Number field to allow for entry 

of a state issued Student ID number so external data can be imported and linked to 
this number for reporting. 

 
 Integration with MARS Intel Reporter:  This system ships with MARS Intel reporter 

Seven built in.  At anytime, the user can switch to MARS Intel Reporter Seven and 
view analytical data using a variety of views, filters and reports.  You can even create 
a specific filter in MARS Intel Reporter and bring it back to work with these selected 
student in MARS Opportunity. 

 
 
Note:  Some functions may not be available in different models or highly custom versions of MARS Opportunity at 
this time.  These include Express Entry and Virtual Groups.  If your application installs from a specific web address 
for your district only, you are running a custom version of MARS Opportunity 7.  Screens shown in this paper may 
change, and other functions may be added that are not described in this document.



MARS System 7 Draft:  10/28/2012 Page 11 of 19 

MARS Intel Reporter Seven 

 
History: 
MARS Intel Reporter Seven is a very different application then previous versions of MARS In-
tel Reporter.  Six years ago when we initially introduced MARS Intel Reporter, it was de-
signed to be a program to “crosstab” data and count/sum the totals from different aggregate 
types.  It was also designed for a data savvy researcher who really understood relational 
data.  If you were that kind of person who “got it,” it was a very useful program and worked 
very well. 
 
Unfortunately, if you weren’t on the “got it” list and you did not have the time to learn how to 
use the application, it turned out to be very cryptic and in many cases, far too cumbersome 
for typical end-users.   
 
One thing the original MARS Intel Reporter did not do very well was create simple list of stu-
dents.  In fairness, the original system was never designed to create lists of students, al-
though it could with some fancy footwork and spreadsheet manipulation. 
 
The previous versions created spreadsheets that you would have to finish in MS Excel.  This 
worked okay for exporting a list if you were trying to get a list of students from the MARS cen-
sus tables where the student name/ID values are exclusive, but required some fairly ad-
vanced spreadsheet skills if you wanted to get a list of unique students who received a spe-
cific set of services. Because students could have been serviced more than once, the stu-
dent’s name/ID could appear many times in the resulting spreadsheet that the end-user 
would have to filter out on his own. 
 
Another downside in the early MARS Intel Reporter version when counting things like ser-
vices, the end-user could either count services to a student or count unique students.  In 
many cases, end-users would count total services for each student, thinking they were count-
ing unique students and end up with what appeared to be erroneous data.  It wasn’t that the 
data was erroneous, but the way they selected the count total was not correct. 
 
For these reasons, until we released this new version, we at MARS Group decided to install 
the old system only with people who were clearly very data savvy, and at the time, we elected 
to design a custom report(s) to the specifications needed by the client and integrate them into 
their MARS System as a customization, mostly at no additional cost. We think this new sys-
tem will provide research people with the granular data access they desire, along with being 
easy for even a beginner to quickly pull clear, accurate reports.  
 
MARS Intel Reporter Seven: 
The new application is designed to be very intuitive, so you really don’t need to be a re-
searcher to operate it.  The system functions pretty much as what you see is what you get.  
You select a spreadsheet style data list from the “Select Data List” menu for say, “Services,” 
and then apply any filters to the data by just right clicking into a cell in the data grid.  The 
lower report section displays the filtered data in your desired report type template.  You can 
change report templates on the fly for the following types depending upon your selected data 
list: 
 
Most people “get it” after just a few minutes of instruction.  The system is set up to work from 
simple functions such as applying a filter and selecting a report, to very advanced functions 
such as bringing in an external spreadsheet and matching to students.  In the most simple 
operation, the user views all the data in a spreadsheet style view, right clicks cells to include 
or exclude values in the display, and then selects a report they desire to be printed.  Select-
able reports include (at this time): 
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 Various Aggregate Reports:  Displays the template’s row group along side column 
groups for the field’s entry values, clearly labeled by the count type (i.e. “Unique Stu-
dent Totals”). 

 
 Composition Reports:  Displays the total of the count types that are part of a single 

field value that in total will add up to 100% (mutually exclusive) of the filtered popula-
tion.  Optional pie chart for the total. 

 
 Distribution Reports:  Similar to composition, but the values come from more than 

one field value and do not necessarily add up to 100% of the filtered population.  Op-
tional Bar graph. 

 
 Trend Reports:  Can be used with date fields, such as services rendered data.  

Shows the count type aggregated by a time interval such as month the service was 
rendered.  Includes a smooth curve line graph. 

 
 List Reports:  Provide a list of “unique” students with various field values.  Custom 

List provides choice of columns.  This report will take a filtered services data list with 
repetitious students, and resolve them into a unique student list. 

 
 Custom Reports:  Included in the MARS System Seven is a Service Agreement that 

allows for creation of a report type that is not included in the system.  These reports 
are automatically added to all MARS Intel Reporter Seven applications upon each 
start-up when connected to the Internet.  Everyone with a subscription automatically 
receives each added report template. 

 
User Defined Service Groups:  This is a major feature because it allows you to associate 
services delivered by your case managers with a specific program group.  For instance, you 
might have a group for Homeless Reporting, another for Foster Reporting and another group 
for Healthy Start.  Inside of each group, you have the required service attribution that is 
needed for the specific program.  In the example setting below, note how the service attribu-
tion for the top  Report Group Service attribution differs from group to group. 
 
 
 
 
 
 
 
The primary benefit is that the case manager is taken out of the decision making process in 
terms of picking the correct service for a given program.  Instead, the case manager merely 
selects the service that they actually provided, and let the person working with reports deter-
mine what types of services should be attributed to the specific programs service type. 
 
Save Reports with Filter Definition:  This is another major feature because it allows you to 
save a report and most important, it’s specific Data List filter setting for reuse.  Open a saved 
report for a given data list and exactly the same report is opened showing the most current 
data. 
 
Place Saved Reports into Report Groups:  Another major feature because it allows you to 
place a saved report (see previous “Save Report…”) into a reporting group, and then run that 
report from a list.  As an example of this feature’s benefit, for a hypothetical Homeless End of 
Year report requirement, you might need a report that list number of Identified students by 
grade level, another that counts total students who received services listed by Service Group, 
and another for total students for each non-required service provided. 
 

Homeless Group: Trans-
portation 

Foster Group: Di-
rect Services 

Healthy Start:  Parent As-
sistance 

School Bus Passes School Bus Passes Gas Card 
Gas Card Gas Card Food Boxes 
Rental Car Referral Food Boxes… etc. Parent Counseling 
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In this program, you may set these reports up in advance, save them to the appropriate re-
porting group, and then open the required report from a list to print and use! 
 
Import External Data:  You can link to external data such as a spreadsheet that contains in-
formation that can be linked to students with a common ID value such as student ID, or Other 
ID (state SIS number) and use that imported data as filter value for a repot’s data list.  To 
bring in Exit Exam Test Scores, import a list from your test score source such as you SIS or 
state test reporting system, tell it what link field the imported data should use to connect the 
matching students to the MARS data, and then import into the grid.  Go to the grid and right 
click to filter by a specific value such as “Passed”, and select the report template, such as to-
tal students by grade, or a list of students to get a report of the specific MARS program stu-
dents who “Passed” the exit exam. 
 
Export Data:  There are several methods for exporting data from MARS, including “blind” 
transmit to MARS Phobos systems, or by encrypted flat tables with a separate “Key” file for 
use by an evaluator or other research person. 
 
MARS Intel Reporter Seven:   Screen Descriptions 

 

Data List spreadsheet style view:  
This is where you view and select fil-
ters from all entered data. 

Report Control:  This is 
where you save and se-
lect saved reports. 

Report Viewer:  This is where you select, view, print 
and export specific reports that reflect the data you 
selected (filtered) in the top data list section. 
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Works like a spreadsheet! 
 
Selecting Data – Most Simple: 
The example below demonstrates how simple it is to filter data in the data list.  In this case, 
the user has selected (in blue) a cell beneath the Housing column with “Motel” as its entry 
and right clicked to reveal the MARS Data List action menu.  Note that the user selected “In-
clude Filter” as the action.  The result is that only entries that only students with “Motel” as 
their housing will be included in the Data List and the active report in the lower Reports sec-
tion. 
 
The user may continue to add filter upon filter in this manner to get a data list that reflects ex-
actly the students with the matching filter characteristics.  There are ways to select multiple 
values in one operation available from the same action menu (not shown). 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Using Data in an Outside Application – Most Simple: 
A copy function is available from the Data List action menu that allows you to quickly copy 
from the spreadsheet, and paste into another application such as a spreadsheet, email or 
word processor document.  The example below demonstrates this function. 
 
 
 
 
 
 
 
 
 
 
 
 

Apply a data filter by sim-
ply selecting a cell value 
and choosing include or 
exclude. 

Copy/Paste data between 
Windows applications just 
like you would in a spread-
sheet! 
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Report Section: 
Works as what you see in the Data List in the top section, is reflected in the report make-up in 
the lower section, with any data filters applied.  You can maximize either section for a full 
view of the report, or to work with the selected Data List. 
 
 

 
 
 
The screen above 
shows the Report 
section maximized, 
reflecting the Data 
List view of the filtered 
information from the 
previous page. 
 
Screen to the right is 
the maximized Data 
List with the filter 
removed.  
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Select From multiple Data List in your MARS Data! 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
MARS Data List 
 
Demographics: 
 
 Demographics – All Students 
 Demographics – Active Students – School Year 

 
The Student Census Data list contain one row of data for each student entered into 
MARS system data stores.  This data includes all relevant information entered into the 
system.  This information can be filtered, such as an individual Case Manager at a spe-
cific school, and the filter can then be saved with a report for reuse.   
 
The Demographic list is the default list when the program opens, and the end-user can 
choose between using either the All Students list, or the “Active Students – School year 
as the default list. 

 
Services: 
 
 Services Rendered – All Services by Date Range 
 Services Rendered  - Grouped Services 

 
The Services Data List is a view of all services with demographic information attached to 
each row.  The result are multiple rows for each student.  In previous MARS systems, in 
order to work with services data, you needed to export into a spreadsheet or database to 
create a list with individual students, or use one of the pre-defined list reports. 
 
This system allows you to filter your data in the Services Data List, and then use any of 
the report templates to get the information you need, ready formatted for presentation. 
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Services Data List (Continued): 
 
 
 
 
Right:  Services 
Rendered Trends 
report showing the 
filtered Data List re-
sults in a graph of 
total individual stu-
dents who have re-
ceived any service 
in the Data List, 
month to month. 
 
 
 
 
 
 

 
G
rouped Services:  Grouped services are a special set of Data Lists that 
is set by the end-user to allow you to take individual Service Types, and 
place them into specific categories that are applicable to a specific re-
porting entity. 
 
For example, you might provide Bus Tokens, Gas Coupons, and Cloth-
ing store Voucher to students.  In McKinney-Vento Homeless, Bus To-
kens and Gas Coupons may apply to the Transportation category, in 
Foster “Direct Services Rendered,” and the school board may want to 
see all these services as one thing called “Cost Related Services.” 
 
 

Right:  Service Group 
set-up screen section  
for McKinney-Vento 
type services attrib-
uted to Medical Ser-
vices.  Any service 
from Hygiene, Mental 
Health, Medical or Vi-
sion types will be 
show as one service 
called “Medical Ser-
vices” in this Grouped 
Services Data List ex-
ample. 
 
 

 
Creating a service group for each of these reporting entities allows you to 
have specific service category attributions for the specific report target.   
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Services Data List (Continued): 
 
Obviously, this allows end-users to enter into MARS Opportunity what 
they actually do in terms of a service provided, and report groups are 
used to assign the service  information needed into the proper attribution. 

 
 
 
 
Right:  User 
defined Report 
Group selec-
tion. 
 
 
 
 
 
 
Contact Activity Summary: 

 
Contact Activity Summary is the Data List associated with the Contact 
Log in MARS Systems.  In many district with a number of individuals in-
teracting with students and families, this log is vital to managing who has 
done what to whom.  In many cases, districts using this MARS feature 
may get a broader picture of just how much activity is occurring with stu-
dent cases. 

 
 

Link to External Data! 
 
Import External Data:  Allows you to import data such as achievement test scores into any 
Data List, linked by a common field such as Student ID, and then use the information as a 
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filter source.  You can prepare an import spreadsheet from a source such as PowerSchool’s 
import/export functions. 
 

Choose From a Variety of Report Types! 
 
Currently, we have reports 49 different report templates available under the different data 
sets.  We expect to have more than 100 in the next week. Some reports have graphs, some 
create list, some present totals.  And, as part of your support subscription, time is allotted for 
us to create a custom report for something that lies outside of the template designs. 
 
Any new reports are automatically pushed to your system, each time the program opens and 
you accept the update. 
 

Save Reports! 
 
A key feature in this system is the ability top save a report and the filter that you set up, so 
you can rerun the same report at a different time using the same report methodology.   
 

Save Reports into Groups! 
 
You can also save 
reports into end-user 
designed report 
groups.  So, if you 
need to use a differ-
ent set of reports for 
a given project, such 
as end of year report-
ing to a grant source, 
you can create your 
reports with filters in 
advance, and run 
everything you need 
from that group when 
it comes time to do 
that task. 
 
 
There are many more 
features in this report-
ing system.  Please give us a call at (800) 519-0463 for a demonstration with your systems 
MARS data. 
 
 
 
 


